Symantec NetBackup™ for Lotus Notes Administrator's Guide

for UNIX, Windows, and Linux

Release 7.7
Technical Support

Symantec Technical Support maintains support centers globally. Technical Support’s primary role is to respond to specific queries about product features and functionality. The Technical Support group also creates content for our online Knowledge Base. The Technical Support group works collaboratively with the other functional areas within Symantec to answer your questions in a timely fashion. For example, the Technical Support group works with Product Engineering and Symantec Security Response to provide alerting services and virus definition updates.

Symantec’s support offerings include the following:

- A range of support options that give you the flexibility to select the right amount of service for any size organization
- Telephone and/or Web-based support that provides rapid response and up-to-the-minute information
- Upgrade assurance that delivers software upgrades
- Global support purchased on a regional business hours or 24 hours a day, 7 days a week basis
- Premium service offerings that include Account Management Services

For information about Symantec’s support offerings, you can visit our website at the following URL:

support.symantec.com

All support services will be delivered in accordance with your support agreement and the then-current enterprise technical support policy.

Contacting Technical Support

Customers with a current support agreement may access Technical Support information at the following URL:

support.symantec.com

Before contacting Technical Support, make sure you have satisfied the system requirements that are listed in your product documentation. Also, you should be at the computer on which the problem occurred, in case it is necessary to replicate the problem.

When you contact Technical Support, please have the following information available:

- Product release level
- Hardware information
- Available memory, disk space, and NIC information
- Operating system
- Version and patch level
- Network topology
- Router, gateway, and IP address information
- Problem description:
  - Error messages and log files
  - Troubleshooting that was performed before contacting Symantec
  - Recent software configuration changes and network changes

**Licensing and registration**

If your Symantec product requires registration or a license key, access our technical support Web page at the following URL:


**Customer service**

Customer service information is available at the following URL:


Customer Service is available to assist with non-technical questions, such as the following types of issues:

- Questions regarding product licensing or serialization
- Product registration updates, such as address or name changes
- General product information (features, language availability, local dealers)
- Latest information about product updates and upgrades
- Information about upgrade assurance and support contracts
- Information about the Symantec Buying Programs
- Advice about Symantec's technical support options
- Nontechnical presales questions
- Issues that are related to CD-ROMs, DVDs, or manuals
Support agreement resources

If you want to contact Symantec regarding an existing support agreement, please contact the support agreement administration team for your region as follows:

Asia-Pacific and Japan  customercare_apj@symantec.com
Europe, Middle-East, and Africa  semea@symantec.com
North America and Latin America  supportsolutions@symantec.com
Chapter 4 Performing backups and restore of Lotus Notes databases ................................................................. 47

About performing backups and restores of Lotus Notes databases ........................................................................ 47

About performing user-directed backups of a Lotus Notes database ........................................................................ 48

General Options tab ................................................................................................................................................. 48

Lotus Notes Options tab ........................................................................................................................................... 49

Performing a user-directed backup of a Lotus Notes database .................................................................................. 49

About performing a Lotus Notes database restore .................................................................................................. 50

General tab ............................................................................................................................................................... 51

Lotus Notes tab .......................................................................................................................................................... 52

Restoring a Lotus Notes database .............................................................................................................................. 54

Restoring linked databases or directories and manually recreating the link file ......................................................... 56

Restoring linked databases or directories and the link file ......................................................................................... 56

Redirecting a Lotus Notes restore to a different client ................................................................................................. 57

About restoring individual Lotus Notes documents or mail messages ........................................................................ 58

Recovering the Lotus Notes environment .................................................................................................................. 59
Chapter 5 Domino clustering ............................................................... 61
  About Domino clustering components ............................................. 61
  Backing up a Domino replicated or clustered environment .......... 62
  About the restore and recovery in a Domino replicated or clustered
  environment ................................................................................. 63
  Example of clustered environment with four Domino servers ....... 63
  Example of clustered environment with three Domino
  servers ............................................................................................ 64

Chapter 6 Domino partitioned servers .............................................. 66
  About Domino partitioned servers ................................................... 66
  About performing backups in a Domino partitioned server
  environment ................................................................................... 67
  About restoring a Domino partitioned server environment .......... 68

Chapter 7 Domino server multiple installations (UNIX or Linux) ................................................................. 70
  About Domino server multiple installations .................................... 70
  About configuring NetBackup for a multiple Domino server
  environment ................................................................................... 71
  About backups in a multiple Domino server environment .......... 71
  About restores a multiple Domino server environment .......... 72

Chapter 8 Troubleshooting NetBackup for Lotus Notes ............... 73
  About NetBackup for Lotus Notes debug logging ...................... 73
    Enabling the debug logs for a NetBackup for Lotus Notes client
    automatically (Windows) ............................................................ 74
    Debug logs for NetBackup for Lotus Notes backup
    operations ................................................................................... 74
    Debug logs for NetBackup for Lotus Notes restore
    operations ................................................................................... 74
    Setting the debug level on a UNIX client .................................... 75
    Setting the debug level on a NetBackup for Lotus Notes Windows
    client ............................................................................................ 75
  About NetBackup status reports .................................................. 75
    Viewing the progress report of a NetBackup for Lotus Notes
    operation ....................................................................................... 76

Index ................................................................................................. 77
Introduction to NetBackup for Lotus Notes

This chapter includes the following topics:

- About NetBackup for Lotus Notes
- About the features for NetBackup for Lotus Notes
- About supported Lotus Notes database configurations
- About the Lotus Notes database files that can be backed up
- About Lotus database transaction logging styles
- About recycling Lotus database transaction log extents
- About Lotus Notes backup operations
- About Lotus Notes restore operations
- NetBackup documentation

About NetBackup for Lotus Notes

NetBackup for Lotus Notes provides online backups and restores of Lotus Notes databases and individual mailboxes when Domino server has been installed. This capability is provided as an add-on or extension to the NetBackup client software.

The NetBackup for Lotus agent lets you optionally use DB2 as the back end for Lotus Notes databases. For details, refer to TechPDF #274536 at the Symantec Support Web site:

http://www.symantec.com/docs/TECH36844

See “About the features for NetBackup for Lotus Notes” on page 10.
Table 1-1 describes the features of the NetBackup for Lotus Notes agent.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online backup</td>
<td>Lotus Notes databases, mailboxes, and transaction logs can be backed up without taking down the Domino server. This feature ensures the availability of Lotus Notes services and data during the Lotus Notes backup.</td>
</tr>
<tr>
<td>Restore operations</td>
<td>An administrator that uses the NetBackup client can browse Lotus Notes database and mailbox backups and select the ones to be restored.</td>
</tr>
<tr>
<td>Transaction logging</td>
<td>NetBackup for Lotus Notes takes advantage of the ability of Domino to log transactions against one or more Lotus Notes databases and mailboxes. Transaction logging may be circular style, linear style, or archive style.</td>
</tr>
<tr>
<td>Point in time recovery</td>
<td>Transaction logging enables NetBackup for Lotus Notes to perform a point-in-time recovery of a logged Lotus Notes databases and mailboxes.</td>
</tr>
<tr>
<td>Tight NetBackup integration</td>
<td>Tight integration with NetBackup indicates the following:</td>
</tr>
<tr>
<td></td>
<td>■ An administrator already familiar with NetBackup can easily configure and use NetBackup backup and restore Lotus Notes databases and transaction log extents.</td>
</tr>
<tr>
<td></td>
<td>■ Features and strengths of the NetBackup product suite are also available with NetBackup for Lotus Notes. These features include software data compression, scheduled and user-directed operations, and multiple data stream backups. Many of these features are described in detail in the NetBackup Administrator’s Guide, Volume I.</td>
</tr>
<tr>
<td>Central administration</td>
<td>Administrators can define Lotus Notes policies, back up and restore Lotus Notes databases, and back up and restore archive-style transaction log extents from a central location.</td>
</tr>
<tr>
<td>Media management</td>
<td>Lotus Notes database backups are saved directly to a wide variety of storage devices that the NetBackup master server supports.</td>
</tr>
</tbody>
</table>
Table 1-1  Features of NetBackup for Lotus Notes (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automated backups</td>
<td>Administrators can set up schedules for automatic, unattended backups for local or remote clients across the network. These backups can be full or incremental and are managed entirely by the NetBackup server from a central location. The administrator also can manually back up clients.</td>
</tr>
<tr>
<td>Compression of backups</td>
<td>Compression increases backup performance over the network and reduces the size of the backup image that is stored on the disk or tape. This feature is only supported for Lotus Notes clients on Windows.</td>
</tr>
<tr>
<td>Checkpoint restart for backup jobs</td>
<td>With checkpoint restart, NetBackup can retry a failed backup from the last checkpoint rather than restart the entire job. With this feature, the NetBackup administrator can also pause a job and resume it later.</td>
</tr>
<tr>
<td>Backups of Domino Partitioned Server</td>
<td>Administrators can back up databases from Domino partitioned servers.</td>
</tr>
<tr>
<td>(UNIX or Linux) Backups of multiple Domino installations</td>
<td>Administrators can back up databases within multiple Domino installations.</td>
</tr>
</tbody>
</table>

See “About Lotus database transaction logging styles” on page 14.
See “About Lotus Notes backup operations” on page 15.
See “About performing backups and restores of Lotus Notes databases” on page 47.

About supported Lotus Notes database configurations

NetBackup for Lotus Notes supports backups and restores of the following Lotus Notes database configurations:

- Domino server databases
  Domino server manages the Domino server databases. Databases are located in a directory that is referred to as the Domino data directory. Databases can also be linked to this directory by using linked directories or linked databases. Databases can be logged or unlogged.
  Typically the Domino data directory is `/db/notesdata` or `C:\Lotus\Domino\Data`.

- Local databases

  A description of the databases is as follows:
<table>
<thead>
<tr>
<th>Database Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logged Domino Server databases</td>
<td>The database agent has the ability to log transactions against one or more Lotus Notes databases. If transaction logging is enabled on the server, all logged database transactions go into a single transaction log. This log consists of one or more files or extents. Where archive-style transaction logging is used, the archived log files serve as the incremental backup for the logged databases. Transaction logging must be enabled to recover logged databases.</td>
</tr>
<tr>
<td>Unlogged Domino Server databases</td>
<td>An unlogged database is one in which transaction logging is not enabled, or has been disabled for specific server database(s). Unlogged databases are backed up when a full backup is performed. Unlogged databases are also backed up when an incremental backup is performed and the unlogged database has been recently updated. The database can be restored only to the point of the latest database backup.</td>
</tr>
<tr>
<td>Local databases</td>
<td>Local databases are the Lotus Notes databases that are not located in the Domino data directory, cannot be shared, and cannot be logged. Local databases are treated similarly to unlogged Domino server databases when they are backed up and restored.</td>
</tr>
</tbody>
</table>


See “About Lotus Notes backup operations” on page 15.

See “About the features for NetBackup for Lotus Notes” on page 10.

### About the Lotus Notes database files that can be backed up

The following files can be backed up during a backup operation:

- Database files that NetBackup for Lotus Notes supports
  - See “About database files supported by NetBackup for Lotus Notes” on page 12.
- Transaction logs
  - See “About Lotus database transaction logs” on page 13.

See “About performing backups and restores of Lotus Notes databases” on page 47.

See “About backups of Windows network shared folders and UNIX NFS directories” on page 42.

### About database files supported by NetBackup for Lotus Notes

NetBackup for Lotus Notes supports the following database types:
About the Lotus Notes database files that can be backed up

- .NTF Lotus Notes template files
- .NSF Lotus Notes server files
- .BOX Lotus Notes mailbox files

For UNIX clients, you can allow Lotus Notes databases with other extensions to be backed up (or limit the default list of extensions). Create the file `/usr/openv/netbackup/lotus.conf`. If the `lotus.conf` file exists, the default extensions are overridden and only those databases with the extensions listed are backed up. In the `lotus.conf` file, enter each extension on a separate line. Enter only the extension with no leading period or trailing characters.

See “About performing backups and restores of Lotus Notes databases” on page 47.
See “Adding backup selections to a Lotus Notes policy” on page 37.
See “About directives in the backup selections list for Lotus Notes policies” on page 40.

About Lotus database transaction logs

The Domino server has the ability to log transactions against one or more Lotus Notes databases (R5 or later). Because transactions cannot be logged against database versions earlier than Domino R5, these pre-R5 Lotus Notes databases are treated as unlogged databases.

All databases are logged by default when the following occurs:
- The administrator enables transaction logging.
- The database is in the Domino data directory.

All logged database transactions go into a single transaction log that consists of one or more files or extents.

Transaction logging can be either circular, linear, or archive style. When archive-style transaction logging is used, the archive log files can serve as the incremental backup for logged databases.

**Note:** Transaction logging must be enabled to implement the recovery of logged databases.

See “About performing backups and restores of Lotus Notes databases” on page 47.
See “Adding backup selections to a Lotus Notes policy” on page 37.
About Lotus database transaction logging styles

One of three logging styles can be selected for all logged databases: circular, linear, or archive.

<table>
<thead>
<tr>
<th>Transaction logging style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circular</td>
<td>When you enable circular-style logging, the transaction log extents are reused as the size limit of the log file is reached. The reuse saves resources, but limits your recovery options. Transaction log extents are not backed up by database agent when circular-style logging is enabled. Therefore, you can only recover logged Lotus Notes databases to the point in time when the transaction log extents were overwritten.</td>
</tr>
<tr>
<td>Linear</td>
<td>When you enable linear-style logging, the transaction log extents function the same as for circular-style logging, with one exception. With circular-style logging, the size of the transaction log extents are predefined and limited. For linear-style logging, the size of the transaction log extents is user defined and limited in size only by the amount of mass storage available.</td>
</tr>
<tr>
<td>Archive</td>
<td>When you enable archive-style logging, transaction log extents are generated as needed and are limited in number only by the capacity of your mass storage. Archive-style transaction log extents must be backed up, unlike circular-style and linear-style transaction log extents, which cannot be backed up. They can be used as the incremental backup for all logged databases. Backups of the archive-style transaction log extents ensure that the transaction log extents are marked as available to be recycled. These backups also prevent your mass storage from filling up. Unlike circular-style and linear-style logging, archive-style logging does not limit the point in time to which a database can be recovered. With archive-style logging enabled, a logged database can be recovered to any point in time. This time can be any time between when the database itself was last backed up to the current time.</td>
</tr>
</tbody>
</table>

See “About recycling Lotus database transaction log extents” on page 15.
See “About supported Lotus Notes database configurations” on page 11.
About recycling Lotus database transaction log extents

Following either a successful full backup or differential incremental backup, archive-style transaction log extents are marked as ready to be recycled. The database agent does not delete the successfully backed up transaction log extents. The Domino server manages when a transaction log extent is recycled.

See “About Lotus database transaction logging styles” on page 14.
See “About supported Lotus Notes database configurations” on page 11.

About Lotus Notes backup operations

NetBackup provides the following methods to perform backups:

- Automatic backups
- Manual backups
- User-directed backups

For more information on these backup methods and other administrator-directed activities, see the NetBackup Administrator’s Guide, Volume I.

With automatic backups, the NetBackup administrator can schedule backups to occur automatically and unattended, under the control of the NetBackup master server.

The manual backup lets the administrator initiate a full backup or incremental backup that is set up in the policy manager. The manual backup option can be useful for the following situations:

- To test a configuration
- When workstations miss their regular backups
- Before installing new software (to preserve the old configuration)
- To preserve records before a special event such as when companies split or merge

In some cases, it may be useful to create a policy and schedule that you use only for manual backups. Create a manual backup policy by defining a single schedule that does not have a defined backup window (and therefore never executes automatically).

User-directed backups require a User Backup schedule type to be defined in the Lotus-Notes policy. User-directed backups of Lotus Notes databases are similar to backups of normal files.
A user backup of Lotus Notes databases and transaction log extents is identical to a full backup with one exception. Transaction log extents are not marked as ready to be recycled after they are successfully backed up. Because transaction log extents are not recycled, a user backup is similar to a snapshot of the databases at a given point in time. The content of ongoing full and incremental backups is not affected. A user backup is not automatically scheduled and must be initiated on the target client machine.

See “About supported Lotus Notes database configurations” on page 11.
See “About Lotus database transaction logging styles” on page 14.
See “About performing backups and restores of Lotus Notes databases” on page 47.
See “About directives in the backup selections list for Lotus Notes policies” on page 40.
See “About backups of Windows network shared folders and UNIX NFS directories” on page 42.

About Lotus Notes restore operations

An administrator can use the NetBackup client to browse for NetBackup for Lotus Notes backups and select the ones to be restored and recovered. The database agent supports both restore operations and recovery operations. A restore operation lets a user restore any previously backed up Lotus Notes databases.

The following operations are performed during a database restore:

- The Lotus Notes database is taken offline.
- The Lotus Notes database (file data) is restored.
- The Lotus change information is applied.
  - If recovery of logged databases is requested, it is done after all logged and all unlogged databases are restored.
- The Lotus Notes database is recovered (transactions from transaction logs are applied).
- The Lotus Notes database is brought online.

Once the restore is complete, NetBackup attempts to recover all logged databases that were restored. The logged databases that were restored are rolled forward to a specific point in time by using the appropriate transactions from the required transaction logs. Then the databases are brought back online. Any required transaction logs are restored automatically as part of the recovery operation if they were previously backed up and recycled. Do not restore transaction log extents manually.
With a server-directed restore, an administrator can browse Domino Server databases and select the ones you want to restore. NetBackup lets you select the NetBackup server from which files are restored, view the backup history, and select items to restore. You can select a specific client or other clients that were backed up by the selected NetBackup server.

When you redirect to a different client, you can restore to a client other than the one that was originally backed up. You can redirect the Lotus databases or directories. The administrator can direct restores to any NetBackup client (regardless of which client performed the backup). To redirect a restore, the administrator can use the NetBackup Administration Console on the master server or the Remote Administration Console.

For the configuration that is needed for this type of redirected restore, see the NetBackup Administrator’s Guide.

Redirecting a restore to a different path allows a user to restore Lotus Notes databases to directories that are different from the directories from which the databases were backed up.

**NetBackup documentation**

For a complete list of NetBackup technical documents for each supported release, see the NetBackup release notes, Administration, Installation, Troubleshooting, Getting Started, and Solutions Guides page at the following URL:

http://www.symantec.com/docs/DOC5332


Symantec assumes no responsibility for the installation and use of the reader.

The NetBackup landing page on the Symantec Support website contains a list of helpful how-to and product alert topics.
Installing NetBackup for Lotus Notes

This chapter includes the following topics:

- Planning the installation of NetBackup for Lotus Notes
- NetBackup server and client requirements
- Lotus Notes server software requirements
- About license keys for NetBackup for Lotus Notes
- Specifying the Lotus Notes home path (UNIX)
- (UNIX or Linux) About adding new Lotus Notes installations

Planning the installation of NetBackup for Lotus Notes

Table 2-1 shows the major installation steps needed to run NetBackup for Lotus Notes. Each step contains one or more links to pertinent procedures and concepts.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Verify the installation prerequisites.</td>
<td>See “” on page 19.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “NetBackup server and client requirements” on page 19.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See “Lotus Notes server software requirements” on page 20.</td>
</tr>
<tr>
<td>Step</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Step 2</td>
<td>Add the license key for NetBackup for Lotus Notes.</td>
<td>See “About license keys for NetBackup for Lotus Notes” on page 20.</td>
</tr>
<tr>
<td>Step 3</td>
<td>(UNIX or Linux) Specify the Lotus Notes home path.</td>
<td>See “Specifying the Lotus Notes home path (UNIX)” on page 20.</td>
</tr>
</tbody>
</table>

Verify that the NetBackup for Lotus Notes agent is supported on your operating system or platform.

To verify operating system and compatibility

1. Go to the following webpage:
   http://www.netbackup.com/compatibility
2. In the list of documents, click on the following document:
   Application/Database Agent Compatibility List

NetBackup server and client requirements

Verify that the following requirements are met for the NetBackup server:

- The NetBackup server software is installed and operational on the NetBackup server.
  See the NetBackup Installation Guide.

- Make sure that you configure any backup media that the storage unit uses. The number of media volumes that are required depends on several things:
  - The devices that are used and storage capacity of the media
  - The sizes of the databases that you want to back up
  - The amount of data that you want to archive
  - The size of your backups
  - The frequency of backups or archives
  - The length of retention of the backup images
  See the NetBackup Administrator’s Guide, Volume I.

Verify that the following requirements are met for the NetBackup clients:

- The NetBackup client software is installed on the computer that has the databases you want to back up.
To use the new features that are included in NetBackup for Lotus Notes in NetBackup 7.7, you must upgrade your NetBackup for Lotus Notes clients to NetBackup 7.7. The NetBackup media server must use the same version as the NetBackup for Lotus Notes client or a higher version than the client.

Lotus Notes server software requirements

Verify the following regarding the Lotus Notes server software on the NetBackup server or client:

- Lotus Notes server software must be installed and operational. Partition servers are supported. More than one Lotus Notes installation is supported on UNIX.

See “NetBackup server and client requirements” on page 19.

About license keys for NetBackup for Lotus Notes

The NetBackup for Lotus Notes agent is installed with the NetBackup client software. No separate installation is required. A valid license for the agent must exist on the master server.

More information is available on how to add license keys.

See the NetBackup Administrator’s Guide, Volume I.

Specifying the Lotus Notes home path (UNIX)

After you add the license key for NetBackup for Lotus Notes, run this script on the computer where the Lotus Notes vendor software is installed. With this script, NetBackup can gather additional information about your Lotus Notes environment.

To specify the Lotus Notes home path

1. Change to the following directory:
   `/usr/openv/netbackup/bin`
2. Run the following script:
   `./lotusnotes_config`
3. Supply the home path for the database installation. For example:
   `/opt/lotus`
4. Add any other database installations, or enter `n` if you are finished.
If you install a new Lotus Notes installation after you install NetBackup, you need to add this new installation to the NetBackup configuration. This action ensures that all new Lotus Notes installations are included in backup operations.
Configuring NetBackup for Lotus Notes

This chapter includes the following topics:

- About configuring NetBackup for Lotus Notes
- Configuring Lotus fast restores
- Defining properties for a Lotus Notes client
- About configuring a backup policy for a Lotus Notes database
- Configuring a backup policy for Lotus Notes database supporting files

About configuring NetBackup for Lotus Notes

Before you configure NetBackup for Lotus Notes, complete the installation procedure. After you complete the installation procedure, complete the procedures in Table 3-1 to configure your environment.

Table 3-1 Steps to configure NetBackup for Lotus Notes

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Configure Lotus fast restores.</td>
<td>See “Configuring Lotus fast restores” on page 23.</td>
</tr>
</tbody>
</table>
Table 3-1  Steps to configure NetBackup for Lotus Notes (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 3</td>
<td>Configure a backup policy.</td>
<td>See “About configuring a backup policy for a Lotus Notes database” on page 30.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Configure a backup policy for database supporting files.</td>
<td>See “Configuring a backup policy for Lotus Notes database supporting files” on page 43.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Test the configuration settings.</td>
<td>See “” on page 45.</td>
</tr>
</tbody>
</table>

### Configuring Lotus fast restores

During Lotus restores, the NetBackup for Lotus Notes agent automatically restores any recycled transaction logs that are required for recovery. Typically one transaction log extent is restored at a time and recovery is completed for the transactions in that log. Because the restore of the log and application of transactions is a sequential process, the restore and recovery performance is slow. NetBackup prefetches the required transaction logs before recovery. Then multiple transaction logs can be restored at a time and made available for recovery.

**To configure Lotus fast restores**

1. Review the configuration recommendations.
   
   See “About Lotus fast restore configuration recommendations” on page 24.

2. Configure the transaction log cache path.
   
   This location is where NetBackup temporarily stores the prefetched transaction logs.
   
   See “About the transaction log cache path” on page 24.

3. Configure the maximum number of logs to restore.
   
   This setting determines how many transaction logs are restored in a single restore job during recovery.
   
   See “About the maximum number of logs to restore” on page 25.

See “About supported Lotus Notes database configurations” on page 11.

See “Defining properties for a Lotus Notes client” on page 25.

See “Adding backup selections to a Lotus Notes policy” on page 37.
About Lotus fast restore configuration recommendations

Review the following recommendations when you configure fast restores:

- Sufficient disk space must be available for the specified number of logs in the transaction log cache location. ([Transaction log cache path] or [LOTUS_NOTES_LOGCACHEPATH] specifies this location.)

- Symantec recommends that the transaction log cache directory and the Domino transaction log directory be on the same file system. This configuration ensures that the transaction logs are "moved" to the Domino transaction log directory at the time of recovery rather than being "copied." (Copying is time consuming.)

- Symantec recommends that you create the cache directory before you start a restore job.

See “Configuring Lotus fast restores” on page 23.

See “About supported Lotus Notes database configurations” on page 11.

See “About the transaction log cache path” on page 24.

See “Defining properties for a Lotus Notes client” on page 25.

See “Adding backup selections to a Lotus Notes policy” on page 37.

About the transaction log cache path

NetBackup restores the prefetched transaction logs to the directory that is specified by this parameter. This directory can be specified in the parameter [LOTUS_NOTES_LOGCACHEPATH] in the Windows registry or in the bp.conf file.

See “Defining properties for a Lotus Notes client” on page 25.

See “Defining properties for a Lotus Notes client in the bp.conf file” on page 27.

Note the following when you configure the transaction log cache directory:

- If the specified path does not exist it is created during restore. Symantec recommends that you create the cache directory before you start a restore job.

- If the user does not have write permission for the folder, the restore job fails with a Status 5 error.

- If a path is not specified, transaction logs are restored to the original location, the Domino transaction log directory.

- If the value of Maximum number of logs to restore is less than or equal to 1, this path is ignored. The logs are not prefetched; one transaction log extent per job is restored to the Domino server's log directory.

- If there is not sufficient space to restore the specified number of logs, NetBackup tries to restore only the number of logs that can be accommodated. This
calculation is done only if the cache directory is present before the restore job is started.

See “About the maximum number of logs to restore” on page 25.

See “About Lotus fast restore configuration recommendations” on page 24.

See “Configuring Lotus fast restores” on page 23.

See “Adding backup selections to a Lotus Notes policy” on page 37.

About the maximum number of logs to restore

This value specifies the maximum number of transaction logs restored in a single restore job during recovery. This value can also be specified in the parameter LOTUS_NOTES_LOGCACHESIZE in the Windows registry or in the bp.conf file.

See “Defining properties for a Lotus Notes client” on page 25.

See “Defining properties for a Lotus Notes client in the bp.conf file” on page 27.

Note the following when you configure the maximum logs to restore:

■ If negative value or 0 is specified or if the value is not specified, then the default value of 1 is used.

■ If the value is greater than 1 the transaction logs are prefetched only. If the value is less than 1, one transaction log extent per job is restored to the Domino server’s log directory.

See “About the transaction log cache path” on page 24.

See “Adding backup selections to a Lotus Notes policy” on page 37.

Defining properties for a Lotus Notes client

To run backups and restores successfully, the agent needs to know the following:

For Windows:

■ The location of the Lotus program directory (where nserver.exe resides)

  The agent extracts the path from the following key in the Lotus registry:

  HKEY_LOCAL_MACHINE\SOFTWARE\Lotus\Domino\Path

  If this value is not defined or if the value is not correct, add this information in the client properties. You can also edit this information in the Windows registry.

■ The path to the Lotus notes.ini file

■ A temporary directory where NetBackup can store the prefetched transaction logs
The maximum number of logs that can be prefetched in a single restore job, during recovery

For UNIX or Linux:
- The path where the Domino data directory is located
- The location where the Lotus program files reside
- The path to the Lotus notes.ini file
- A temporary directory where NetBackup can store the prefetched transaction logs
- The maximum number of logs that can be prefetched in a single restore job, during recovery

These variables can be set in the client properties. Or you can define these variables in the Windows registry or in the `bp.conf`.


See “Defining the properties for a Lotus Notes client from the Windows registry” on page 27.

See “Defining properties for a Lotus Notes client in the bp.conf file” on page 27.

See “Adding backup selections to a Lotus Notes policy” on page 37.

Defining properties for a Lotus Notes client from the NetBackup Administration Console

The following instructions describe how to define the properties for a Lotus Notes client using the NetBackup Administration Console.

To define properties for a Lotus Notes client from the NetBackup Administration Console

1. Open the NetBackup Administration Console.
2. Expand **NetBackup Management > Host Properties > Clients**.
3. In the right pane, right-click the client name and select **Properties**.
4. In the left pane, expand **Windows Client** or **UNIX client** and select **Lotus Notes**.
5. In the **Client Properties** dialog box, provide the necessary information.
   - See “Lotus Notes properties” on page 28.
6. Click **OK** to save your changes.
Defining the properties for a Lotus Notes client from the Windows registry

The following instructions describe how to define the properties for a Lotus Notes client from the Windows registry.

To define properties for a Lotus Notes client from the Windows registry

1. From the Windows Start menu, select Run.
2. In the Run box, type regedit and press Enter.
3. In the Registry Editor, open the HKEY_LOCAL_MACHINE key and navigate the tree to the following key:

   SOFTWARE\Veritas\NetBackup\CurrentVersion\Config

4. Provide the necessary information.

   See “Lotus Notes properties” on page 28.

5. To close the registry, select File > Exit.

See “Defining properties for a Lotus Notes client” on page 25.

See “Defining the properties for a Lotus Notes client from the Windows registry” on page 27.


Defining properties for a Lotus Notes client in the bp.conf file

The following instructions describe how to define the properties for a Lotus Notes client in the bp.conf file.

To define properties for a Lotus Notes client in the bp.conf file

1. Open the bp.conf file.

   This file is located in install_path/netbackup/.

2. Provide the necessary information.

   See “Lotus Notes properties” on page 28.

3. Save and close the bp.conf file.

See “Defining properties for a Lotus Notes client” on page 25.

See “Adding backup selections to a Lotus Notes policy” on page 37.
Lotus Notes properties

The **Lotus Notes** properties apply to the clients that are currently selected and that run NetBackup for Lotus Notes.

The following properties can be configured in the **Lotus Notes** host properties or by using the `nbgetconfig` and `nbsetconfig` commands.


See “Defining the properties for a Lotus Notes client from the Windows registry” on page 27.

For UNIX servers: If you have multiple installations of Domino server, the values in the client properties or the `bp.conf` only apply to one installation. For other installations, specify the installation path and location of the `notes.ini` file with the `LOTUS_INSTALL_PATH` and `NOTES_INI_PATH` directives in the backup policy.

<table>
<thead>
<tr>
<th>Client host properties</th>
<th>Configuration options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of logs to restore</td>
<td>LOTUS_NOTES_LOGCACHESIZE</td>
<td>The maximum number of logs that can be prefetched in a single restore job during recovery. Specify a value greater than 1. If this value is less than or equal to 1, NetBackup does not gather transaction logs during recovery. One transaction log extent per job is restored to the Domino server’s log directory. <code>LOTUS_NOTES_LOGCACHESIZE = 3</code></td>
</tr>
</tbody>
</table>
### Table 3-2 Lotus Notes client host properties *(continued)*

<table>
<thead>
<tr>
<th>Client host properties</th>
<th>Configuration options</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Transaction log cache path** | LOTUS_NOTES_LOGCACHEPATH | Specify a path where NetBackup can temporarily store the prefetched transaction logs during recovery. For example:  
  - **On Windows:** D:\LogCache  
  - **On UNIX:** /tmp/logcache  
  
  If you do not specify a path, during recovery NetBackup restores the logs to the Domino server's transaction log directory.  
  Note the following before specifying the Transaction log cache path:  
  - If the specified path does not exist then it is created during restore.  
  - The restore job fails with a Status 5 error if the user does not have write permission for the folder.  
  - Transaction logs are restored to the original location, the Domino transaction log directory, if a path is not specified.  
  - If the value of Maximum number of logs to restore is less than or equal to 1 then this path is ignored. The logs are not prefetched; one transaction log per job is restored to the Domino Server's log directory.  
  - If there is not sufficient space to restore the specified number of logs, NetBackup tries to restore only the number of logs that can be accommodated. |
| **INI path** | LOTUS_NOTES_INI | Enter the NOTES.INI file that is associated with the server used to back up and restore the Lotus database. Use this setting to specify the correct .INI file to back up and restore from Domino partitioned servers. Specifying the .INI file for non-partitioned servers is not necessary.  
  
  Specify the absolute path to the NOTES.INI file:  
  - **On Windows:** If the notes.ini file is not located in the default directory, indicate its location in the INI path box. For example: D:\Lotus\Domino\notes.ini  
  - **On UNIX:** If the notes.ini is not located in the directory that is specified in the Path, indicate its location here. For example: /db/notesdata/notes.ini  
  
  Include the directory and the notes.ini file name. |
### Table 3-2  Lotus Notes client host properties (continued)

<table>
<thead>
<tr>
<th>Client host properties</th>
<th>Configuration options</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Path**               | LOTUS_NOTES_PATH       | Specify the path where the Lotus Notes program files reside on the client. NetBackup must know where these files are to perform backup and restore operations. The value in this box overrides the Lotus registry key, if both are defined. Specify the path where the Lotus Notes program files reside on the client:  
  - **On Windows:** Specify the path for Lotus program directory (where nsserver.exe resides). For example: D:\Lotus\Domino  
  - **On UNIX:** Specify a path that includes the Domino data directory, the Lotus program directory, and the Lotus resource directory. For example:  
    `/export/home/notesdata:/opt/lotus/notes/latest/sunspa:/opt/lotus/notes/latest/sunspa/res/C`  
  The **Path** value overrides the Lotus registry value, if both are defined. |

### About configuring a backup policy for a Lotus Notes database

A backup policy for a database defines the backup criteria for a specific group of one or more clients. These criteria include the following:

- Storage unit and media to use
- Policy attributes
- Backup schedules
- Clients to be backed up
- Items to be backed up, including a list of databases and directives

To back up the database environment, define at least one Lotus-Notes policy with the appropriate schedules. A configuration can have a single policy that includes all clients, or there can be many policies, some of which include only one client.
In addition to the Lotus-Notes policy, configure a Standard or MS-Windows policy to back up database supporting files.

See “Configuring a backup policy for Lotus Notes database supporting files” on page 43.

Most requirements for database policies are the same as for file system backups. In addition to the policy attributes for this database agent, other attributes are available that you should consider.

See the NetBackup Administrator’s Guide, Volume I.

To add and configure a policy, see the following topics:

■ See “About policy attributes” on page 32.
■ See “Adding schedules to a NetBackup for Lotus Notes policy” on page 33.
■ See “Adding clients to a policy” on page 37.
■ See “Adding backup selections to a Lotus Notes policy” on page 37.

Adding a new NetBackup for Lotus Notes policy

This topic describes how to add a new backup policy for a database.

To create a policy to back up database supporting files, you need to perform a different procedure.

See “Configuring a backup policy for Lotus Notes database supporting files” on page 43.

To add a new NetBackup for Lotus Notes policy

1 Log on to the master server as administrator (Windows) or root (UNIX).
2 Start the NetBackup Administration Console.
3 If your site has more than one master server, choose the one on which you want to add the policy.
4 In the NetBackup Administration Console, select NetBackup Management > Policies. Then select Actions > New > Policy.
5 In the Add a New Policy dialog box, in the Policy name box, type a unique name for the new policy.
6 Click OK.
7 In the Add New Policy dialog box, in the Policy type list, select Lotus-Notes.

The Lotus-Notes policy type does not appear in the drop-down list unless your master server has a license key for the database agent.
8 Complete the entries on the **Attributes** tab.

See “About policy attributes” on page 32.

9 Add other policy information as follows:

- Add schedules.
  See “Adding schedules to a NetBackup for Lotus Notes policy” on page 33.

- Add clients.
  See “Adding clients to a policy” on page 37.

- Add database objects to the backup selections list.
  See “Adding backup selections to a Lotus Notes policy” on page 37.

10 When you have added all the schedules, clients, and backup selections you need, click **OK**.

---

### About policy attributes

With a few exceptions, NetBackup manages the policy attributes set for a database backup like a file system backup. Other policy attributes vary according to your specific backup strategy and system configuration.

**Table 3-3** describes some of the policy attributes available for a NetBackup for Lotus Notes policy. For more information on policy attributes, see the *NetBackup Administrator’s Guide, Volume I*.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy type</td>
<td>Determines the types of clients that can be backed up with the policy. For Lotus Notes databases, select the policy type Lotus-Notes.</td>
</tr>
<tr>
<td>Take checkpoints</td>
<td>Enable this feature to have NetBackup take checkpoints during the backup jobs for the policy. The checkpoint frequency indicates how often NetBackup takes a checkpoint during a backup. The default is 15 minutes. The <strong>Schedule backup attempts</strong> global attribute indicates the number of times that NetBackup attempts a failed backup.</td>
</tr>
<tr>
<td>every</td>
<td></td>
</tr>
<tr>
<td>Compress</td>
<td>Enables the compression of backups. This option is only supported for NetBackup for Lotus clients for Windows. A NetBackup for Lotus client on UNIX cannot perform compression. If you want to use compression and have both Windows and UNIX clients, create two backup policies. Use one policy for Windows clients and one policy for UNIX clients.</td>
</tr>
</tbody>
</table>

For more information on advantages and disadvantages of compression, see the *NetBackup Administrator’s Guide, Volume I*. |
Table 3-3  Policy attribute descriptions for NetBackup for Lotus Notes policies (continued)

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow multiple data streams</td>
<td>Specifies that NetBackup can divide automatic backups for each client into multiple jobs. Each job backs up only a part of the list of backup selections. The jobs are in separate data streams and can occur concurrently. The number of available storage units, multiplex settings, and the maximum jobs parameters determine the total number of streams and how many can run concurrently. Not all directives in the backup selections list allow for multiple database streams.</td>
</tr>
<tr>
<td>Keyword phrase</td>
<td>A textual description of a backup. Useful for browsing backups and restores.</td>
</tr>
</tbody>
</table>

Adding schedules to a NetBackup for Lotus Notes policy

Each policy has its own set of schedules. These schedules control the initiation of automatic backups and also specify when user operations can be initiated.

To add a schedule to a NetBackup for Lotus Notes policy

1  In the Policy dialog box, click the Schedules tab.

   To access the Policy dialog box, double-click the policy name in the Policies list in the NetBackup Administration Console.

2  Click New.

3  Specify a unique name for the schedule.

4  Select the Type of backup.

   See “NetBackup for Lotus Notes backup types” on page 34.

5  Specify the other properties for the schedule.

   See “About schedule properties ” on page 33.

6  Click OK.

About schedule properties

This topic describes the schedule properties that have a different meaning for database backups than for file system backups. Other schedule properties vary according to your specific backup strategy and system configuration. Additional information about other schedule properties is available. See the NetBackup Administrator’s Guide, Volume I.
Table 3-4 Description of schedule properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of backup</td>
<td>Specifies the type of backup that this schedule can control. The selection list shows only the backup types that apply to the policy you want to configure. See “NetBackup for Lotus Notes backup types” on page 34.</td>
</tr>
</tbody>
</table>
| Schedule type    | You can schedule an automatic backup in one of the following ways:  
|                  | ■ Frequency  
|                  | Frequency specifies the period of time that can elapse until the next backup operation begins on this schedule. For example, assume that the frequency is 7 days and a successful backup occurs on Wednesday. The next full backup does not occur until the following Wednesday. Typically, incremental backups have a shorter frequency than full backups.  
|                  | ■ Calendar  
|                  | The Calendar option lets you schedule the backup operations that are based on specific dates, recurring week days, or recurring days of the month. |
| Retention        | Specifies a retention period to keep backup copies of files before they are deleted. The retention level also denotes a schedules priority within the policy. A higher level has a higher priority. Set the time period to retain at least two full backups of your database. In this way, if one full backup is lost, you have another full backup to restore. For example, if your database is backed up once every Sunday morning, you should select a retention period of at least 2 weeks. |

NetBackup for Lotus Notes backup types

In a policy’s schedule you define the type of backup(s) you want to perform.  
See “Adding schedules to a NetBackup for Lotus Notes policy” on page 33.

Table 3-5 Description of backups types

<table>
<thead>
<tr>
<th>Type of backup</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full backup</td>
<td>This backup type is used to back up all the Lotus databases that are identified in the Backup Selections list. Available transaction logs extents are also backed up if the BACKUP_TRANSACTION_LOGS directive is specified in the Backup Selections list. All transaction log extents are backed up that are identified as available for backup by the Domino server. The inactive transaction log extents are marked as ready to be recycled after they are successfully backed up. The Domino server handles the actual recycling of transaction log extents.</td>
</tr>
</tbody>
</table>
### Table 3-5  Description of backups types *(continued)*

<table>
<thead>
<tr>
<th>Type of backup</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Differential Incremental backup</strong></td>
<td>The type of Lotus Notes database affects how NetBackup performs a differential incremental backup, as follows:</td>
</tr>
<tr>
<td>■ Unlogged databases or local databases</td>
<td>Backs up all unlogged databases or local databases that were modified since the last full or incremental backup. The last modification date, not the time stamp or date stamp of the database file, determines the time the database was last modified.</td>
</tr>
<tr>
<td>■ Logged databases (archival-style logging enabled)</td>
<td>Backs up only those logged databases that were assigned a new DBIID since the last full or incremental backup.</td>
</tr>
<tr>
<td>■ Logged databases (circular-style and linear-style logging enabled)</td>
<td>Backs up all logged databases that were modified or assigned a new DBIID since the last full or incremental backup. The last modification date, not the time stamp or date stamp of the database file, determines the time the database was last modified.</td>
</tr>
<tr>
<td>■ Transaction logs</td>
<td>Backs up all transaction log extents that are identified as available for backup by the Domino server. The inactive transaction log extents are marked as ready to be recycled when the backup completes successfully.</td>
</tr>
</tbody>
</table>

See *“About supported Lotus Notes database configurations”* on page 11.
### Table 3-5

<table>
<thead>
<tr>
<th>Type of backup</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cumulative Incremental backup</td>
<td>The type of Lotus Notes database that is encountered affects how NetBackup performs a cumulative incremental backup, as follows;</td>
</tr>
<tr>
<td>■ Unlogged databases or local databases</td>
<td>Backs up all unlogged databases or local databases that were modified since the last full backup. The last modification date, not the time stamp or date stamp of the database file, determines the time the database was last modified.</td>
</tr>
<tr>
<td>■ Logged databases (archival-style logging enabled)</td>
<td>Backs up only those logged databases that were assigned a new DBIID since the last full backup.</td>
</tr>
<tr>
<td>■ Logged databases (circular-style and linear-style logging enabled)</td>
<td>Backs up all logged databases that were modified or have been assigned a new DBIID since the last full backup. The last modification date, not the timestamp or date stamp of the database file, determines the time the database was last modified.</td>
</tr>
<tr>
<td>■ Transaction logs</td>
<td>Backs up all transaction log extents that are identified as available for backup by the Domino server. The transaction log extents are not marked as ready to be recycled when the backup is completed.</td>
</tr>
</tbody>
</table>

See “About supported Lotus Notes database configurations” on page 11.

| User backup | A user backup is identical to a full backup with one exception. Transaction log extents are not marked as ready to be recycled after they are successfully backed up. Because transaction log extents are not recycled, a user backup is similar to a snapshot of the databases at a given point in time. The content of ongoing full and incremental backups is not impacted. |
| A user backup is not automatically scheduled and must be initiated on the target client machine. |
| You may want to consider creating a separate policy for User Backup schedule types. This configuration lets you easily separate user-directed and scheduled backups. If you decide to create a separate policy for user backups, the considerations are similar to those for automatic backups. One difference is that you do not need to indicate any backup selections because users select the files. |

See “Adding backup selections to a Lotus Notes policy” on page 37.
Adding clients to a policy

The clients list contains a list of the clients that are backed up during an automatic backup. A NetBackup client must be in at least one policy but can be in more than one.

If you want to back up multiple clients, the Lotus Domino Server install path and the `notes.ini` location must be identical for each client. If not, the clients must be backed up through separate policies.

For a NetBackup for Lotus Notes policy, clients you want to add must have the following software installed:

- The Lotus Domino Server or Lotus client
- NetBackup client or server

To add clients to a NetBackup for Lotus Notes policy

1. Open the policy you want to edit or create a new policy.
2. Click the Clients tab.
   
   To access the Policy dialog box, double-click the policy name in the Policies list in the NetBackup Administration Console.
3. Click New.
4. Type the name of the client and select the hardware and operating system of the client.
5. Choose one of the following:
   - To add another client, click Add.
   - If this client is the last client you want to add, click OK.
6. In the Policy dialog box, click OK.

Adding backup selections to a Lotus Notes policy

The backup selections list names the databases and directives that NetBackup includes in automatic backups of the clients that are included in the policy. NetBackup uses the same backup selection list for all clients that are backed up by the policy.

You should back up the following files:

- All files in the Domino data directory
- Any databases that reside outside of the Domino data directory
- All `.id` files
All notes.ini files

The agent only backs up the databases and directives in the backup selections lists. To exclude databases from a backup, place them outside the Domino data directory.

See “About excluding Lotus Notes databases from backups” on page 42.

To back up database links and directory links correctly, you must include the local and the linked directory in the backup selections list.

See “About backups of Lotus database links and directory links” on page 43.

To create a list of items to back up, perform the following procedures:

- See “Adding directives to the Lotus Notes backup selections list” on page 38.
- See “Adding Lotus databases to the backup selections list” on page 39.

Adding directives to the Lotus Notes backup selections list

The following procedure describes how to add directives to the backup selections list.

To add directives to the Lotus Notes backup selections list

1. In the Policy dialog box, click the Backup Selections tab.
   
   To open the Policy dialog box, double-click the policy name in the Policies list in the NetBackup Administration Console.

2. Click New.

3. Add the directives you want to the backup selections list.
   
   From the Windows interface:
   
   - Click the Directives button.
   - In the Select Directive dialog box, select the Directive Set.
   - From the Directive list, select a directive.
   - Click OK.

   From the Java interface:

   - In the Add Backup Selection dialog box, click the arrow button to the right of the Pathname or directive box and select a directive.
   - Click Add.
   - Click OK.
See “About directives in the backup selections list for Lotus Notes policies” on page 40.

4 In the Policy dialog box, click OK.

Any pathnames or directives you specified are appended to the Backup Selections list.

Adding Lotus databases to the backup selections list

The following procedure describes how to add databases to the backup selections list.

To add databases to the backup selections list

1 In the Policy dialog box, click the Backup Selections tab.

To open the Policy dialog box, double-click the policy name in the Policies list in the NetBackup Administration Console.

2 Click New.

3 Indicate the database or directory to back up.

From the Windows interface:

- Click the Remote Folder button and select the database or directory.
  Or type the full path and name of the database or directory.
  You can indicate an NFS pathname or a UNC pathname in the Backup Selections list. For example:
  /export/home/lotus/data (NFS pathname)
  \hostname\share\lotus\data (UNC pathname)
  For linked databases and directories, include the pathname to the source databases or directory.

- Continue to add any other databases and directories to the list.

From the Java interface:

- In the Pathname or directive box, type the full path name of a database or directory.
  You can indicate an NFS pathname or a UNC pathname in the Backup Selections list. For example,
  /export/home/lotus/data (NFS pathname)
  \hostname\share\lotus\data (UNC pathname)
  For linked databases and directories, include the pathname to the source databases or directory.

- Click Add.
Continue to add any other databases and directories to the list.

When you have added all the databases or directories, in the Add Backup Selection dialog box, click **OK**.

4  In the **Policy dialog** box, click **OK**.

See “Adding backup selections to a Lotus Notes policy” on page 37.

See “About directives in the backup selections list for Lotus Notes policies” on page 40.

See “About excluding Lotus Notes databases from backups” on page 42.

### About directives in the backup selections list for Lotus Notes policies

You can add directives to the backup selections list to indicate database objects you want to back up. More information is available on backup selections.

See “Adding backup selections to a Lotus Notes policy” on page 37.

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL_LOTUS_DATABASES</td>
<td>Performs the backup on all Lotus Notes databases on each of the selected clients. <strong>ALL_LOTUS_DATABASES</strong> means both local databases and Domino server databases.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>This directive is supported only on UNIX clients. For Windows clients, create a backup selections list that includes the directories that contain the actual Lotus Notes databases.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Using the <strong>ALL_LOTUS_DATABASES</strong> directive can have tremendous performance issues on clients with large or multiple local drives. In this case, specify more specific directories or databases in the backup selections list. For example, specify the Domino data directory.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>If this directive is encountered during a backup of a Lotus-Notes Windows client, the backup fails with a <strong>status 69: The file list string is invalid</strong>. If you have both UNIX and Windows clients, create at least two policies: one exclusively for UNIX clients and another exclusively for Windows clients.</td>
</tr>
</tbody>
</table>

| BACKUP_TRANSACTION_LOGS          | Backs up all transaction log extents that Domino server identifies as available for backup.                                               |
Table 3-6 Lotus Notes directives in the backup selections list (continued)

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NEW_STREAM</td>
<td>In a backup policy, the <strong>NEW_STREAM</strong> directive is used to define a new stream of data. A stream can be any one of the following:</td>
</tr>
<tr>
<td></td>
<td>- A single stream for a particular partition of a Domino partitioned server</td>
</tr>
<tr>
<td></td>
<td>- Multiple streams for a single partition on a non-partitioned Domino server</td>
</tr>
<tr>
<td></td>
<td>- (UNIX or Linux) A single stream for a particular installation of Domino server installed on a client</td>
</tr>
<tr>
<td></td>
<td>To use the <strong>NEW_STREAM</strong> directive, the <strong>Allow multiple data streams</strong> attribute must be enabled for the policy on the <strong>Attributes</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>To schedule a backup of more than one partition from a single policy, you must back up each Domino partition with a separate data stream. Use the <strong>NEW_STREAM</strong> directive and the <strong>NOTES_INI_PATH=</strong> directive for each data stream.</td>
</tr>
<tr>
<td></td>
<td>(UNIX or Linux) To schedule a backup of multiple installations of Domino server on the same host, backup each Domino server with a separate data stream. Use the <strong>NEW_STREAM</strong> directive and the <strong>NOTES_INI_PATH</strong> and <strong>LOTUS_INSTALL_PATH</strong> directives for each data stream.</td>
</tr>
<tr>
<td></td>
<td>For more information on the <strong>NEW_STREAM</strong> directive, see the NetBackup Administrator's Guide, Volume I.</td>
</tr>
<tr>
<td>NOTES_INI_PATH=</td>
<td>This directive identifies the location of the notes.ini file that is associated with the particular server partition that is used to perform the backup.</td>
</tr>
<tr>
<td></td>
<td>(UNIX or Linux) This directive can also identify the notes.ini file that is associated with the particular server installation that is used to perform the backup.</td>
</tr>
<tr>
<td></td>
<td>To configure a backup for a Domino partitioned server, use this directive to indicate the absolute path for the notes.ini file. This file should be associated with the server partition you want to use. The server partition that is specified has an effect on how a database is backed up (logged or unlogged). It also affects which set of transaction log extents is backed up.</td>
</tr>
<tr>
<td></td>
<td>(UNIX or Linux)</td>
</tr>
<tr>
<td></td>
<td>To configure a backup for one of the multiple installations of Domino server, use this directive to indicate the absolute path for the notes.ini file. This notes.ini file should be associated with the server installation to be used.</td>
</tr>
</tbody>
</table>
Table 3-6  Lotus Notes directives in the backup selections list (continued)

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOTUS_INSTALL_PATH=</td>
<td>This directive identifies the location of Lotus program files that are associated with a particular installation of Domino server.</td>
</tr>
<tr>
<td></td>
<td>(UNIX or Linux) To configure a backup for one of the multiple installations of Domino server, indicate the absolute path where the Lotus program files are installed.</td>
</tr>
</tbody>
</table>

About backups of Windows network shared folders and UNIX NFS directories

The NetBackup for Lotus Notes agent can back up Windows network shared folders and UNIX NFS directories. A Windows UNC or UNIX NFS pathname can be added in the Backup Selections list of the Lotus Notes policy. This capability is useful when Lotus Notes databases reside on network storage such as NAS filers.

Consult the NetBackup System Administrator’s Guide, Volume I, for detailed instructions on how to back up network drives and the Follow NFS policy attribute.

Contact your IBM Lotus Notes representative to determine if this capability is appropriate and supported within your Domino environment. This capability within NetBackup does not imply support by IBM. IBM has published a document, Statement of Support for Domino on SAN and NAS equipment, regarding Domino in SAN/NAS environments:

http://www-1.ibm.com/support/docview.wss?uid=swg27002613

About excluding Lotus Notes databases from backups

You can exclude specific Lotus Notes databases from the backup by using database links and directory links. This method works if the databases to which the links point are located outside of the Domino data directory.

Identify the databases you want to exclude and move them to a directory outside the Domino data path. Then, create a Domino database or a directory link to the database(s). The agent only backs up files with extensions .nsf, .ntf and .box, and does not follow database links or directory links.

If you need assistance to create a Domino database or directory links, consult a Domino administrator. Or visit the IBM Support Web site and review IBM Technote #1089707:

www.lotus.com/support
About backups of Lotus database links and directory links

The agent only backs up database files with *.nsf, *.ntf, and *.box extensions in the directories that are specified in the backup selections list of the policy. The agent does not automatically follow database links or directory links to the actual databases.

To correctly back up linked databases or linked directories outside of the Domino data directory, in the backup selections list add the following:

- The directory containing the Lotus Notes databases
- The directory containing the database link (.nsf file)
  OR
- The directory containing the directory link (.dir file)

For example, assume that you have a database link file that points to a database. On Windows, the link file C:\Domino\Data\database.nsf points to the database E:\Lotus\Data\link.nsf.

On UNIX or Linux, the link file /db/notesdata/mail/database.nsf points to the database /lotus/data/link.nsf.

To correctly back up the database.nsf file, the backup selection list needs to include the following entries:

Windows

C:\Domino\Data
E:\Lotus\Data

UNIX or Linux

/db/notesdata/mail/
/lotus/data/

Configuring a backup policy for Lotus Notes database supporting files

To properly back up a database environment, you must back up not only database files but also the database supporting files. To back up supporting files for a Lotus Notes environment, do the following: back up all local drives but exclude the database and the transaction logs from the backup.

To configure a policy to back up database files, you need to follow a different procedure.

See “About configuring a backup policy for a Lotus Notes database” on page 30.
To configure a NetBackup for Lotus Notes backup policy for database supporting files

1. Log on to the master server as administrator (Windows) or root (UNIX).
2. Open the NetBackup Administration Console.
3. If your site has more than one master server, select the one on which you want to add the policy.
4. In the left pane, right-click **Policies** and select **New Policy**.
5. In the **Add a New Policy** dialog box, in the **Policy name** field, type a unique name for the new policy.
6. Click **OK**.
7. Click the **Attributes** tab.
8. From the **Policy type** box, select **MS-Windows** (Windows) or **Standard** (UNIX).
9. Select other attributes you want.
   For more information on attributes for these types of policies, see the *NetBackup Administrator’s Guide, Volume I*.
10. Click the **Schedules** tab and configure the schedules for this policy.
   For more information on schedules for these types of policies, see the *NetBackup Administrator’s Guide, Volume I*.
11. Click the **Clients** tab and add the clients that you want to back up with this policy.
   For more information on how to add clients to these types of policies, see the *NetBackup Administrator’s Guide, Volume I*.
12. Click the **Backup Selections** tab.
13. Click **New**.
14. Add the **ALL_LOCAL_DRIVES** directive to the backup selections list.
   From the Windows interface
   - Click the **Directives** icon.
     - In the **Select Directive** dialog box, select the **Directive Set**.
     - From the **Directive** list, select **ALL_LOCAL_DRIVES**.
     - Click **OK**.
   From the Java interface:
In the Add Backup Selection dialog box, from the Pathname or directive list, select ALL_LOCAL_DRIVES.

- Click Add.
- Click OK.

15 In the Policy dialog box, click OK.

16 Continue with the instructions for excluding database files from the backup of a Windows client or a UNIX client.

To exclude database files from a backup of a Windows client

1  Open the NetBackup Administration Console.

2  From the left pane, click NetBackup Management > Host Properties > Clients.

3  In the right pane, select each of the database clients.

4  Right-click a client name and click Properties.

5  In the Client Properties dialog box, expand Windows Client and click Exclude Lists.

6  For the policy you created to back up the database supporting files, add the following file types to the list: .nsf, .ntf, .box, .TXN.

   See the NetBackup Administrator’s Guide, Volume I, for details on how to create exclude lists.

7  Click OK.

To exclude database files from a backup of a UNIX client

1  On each database client, create the following file:

   /usr/openv/netbackup/exclude_list

2  In the exclude_list file, add the following file types to the list: .nsf, .ntf, .box, .TXN.

   After you configure the servers and clients in your environment, you can test the configuration settings with a manual backup. Perform a manual backup (or backups) with the automatic backup schedules you created. A description of status codes and other troubleshooting information is available.

   See the NetBackup Status Codes Reference Guide.

   See the NetBackup Troubleshooting Guide.
To perform a manual backup

1. Log onto the master server as administrator (Windows) or root (UNIX).
2. Start the NetBackup Administration Console.
3. In the left pane, click Policies.
4. In the All Policies pane, select the policy you want to test.
6. Select the schedule that you want to use for the manual backup.
7. To check the status of the backup, click Activity Monitor in the NetBackup Administration Console.
Performing backups and restore of Lotus Notes databases

This chapter includes the following topics:

■ About performing backups and restores of Lotus Notes databases
■ About performing user-directed backups of a Lotus Notes database
■ About performing a Lotus Notes database restore
■ Redirecting a Lotus Notes restore to a different client
■ About restoring individual Lotus Notes documents or mail messages
■ Recovering the Lotus Notes environment

About performing backups and restores of Lotus Notes databases

Before you perform backups or restores, complete the configuration procedures. You then can use the Backup, Archive, and Restore interface to back up Lotus Notes databases, mailboxes, transaction log extents, or directories.
About performing user-directed backups of a Lotus Notes database

These instructions describe a user-directed backup of a Lotus Notes database using NetBackup. This information is a supplement to the operating instructions in the NetBackup Backup, Archive, and Restore Getting Started Guide. Refer to that guide for detailed backup instructions.

Note: When a user-directed backup is successfully completed, transaction log extents are not marked as ready to be recycled. Therefore, user-directed backups should be used for special situations and should not replace regularly scheduled full backups or incremental backups.

General Options tab

The following options are available for backup operations of Lotus Notes databases.

Table 4-1 General Options tab Lotus Notes backup operations

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contains a list of objects to be backed up.</td>
<td></td>
</tr>
<tr>
<td>Specify the absolute path for the NOTES.INI file associated with the server instance to be used</td>
<td>To back up a Domino partition server or one of Domino installations, specify the absolute path for the notes.ini file. This notes.ini file should be associated with the particular server partition or installation that you want to use to perform the backup. The partition you specify affects how a database is backed up (if logged). It also affects which set of transaction logs are backed up.</td>
</tr>
<tr>
<td>Keyword phrase to associate with this backup or archive (optional)</td>
<td>Specifies a keyword phrase, up to 128 characters in length, that NetBackup can associate with the image created by this backup operation. You then can restore the image by specifying the keyword phrase in the Search Backups dialog box. All printable characters are permitted including space (&quot; &quot;) and period (&quot;.&quot;). The default keyword phrase is the null (empty) string</td>
</tr>
</tbody>
</table>
Lotus Notes Options tab

Use the **Lotus Notes Options** tab to specify the absolute path for the `notes.ini` file.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Specify the absolute path for the NOTES.INI file for the server instance</strong></td>
<td>To back up a Domino partition server, specify the absolute path for the <code>notes.ini</code> file. This file should be associated with the particular server partition that you want to perform the backup. The server partition you specify affects how a database is backed up (if logged). It also affects which set of transaction logs is backed up.</td>
</tr>
</tbody>
</table>

Performing a user-directed backup of a Lotus database

The following procedure describes how to perform a user-directed backup.

**To perform a user-directed backup of a Lotus database**

1. Open the Backup, Archive, and Restore interface.
2. (Windows) Select **File > Select Files and Folders to Back Up**.
3. (UNIX or Linux) Click the **Backup Files** tab.
   - The Lotus Notes object appears in the left pane. Select items within this object that you want to back up. These objects include logged and unlogged Domino server databases, local databases, and archive-style transaction log extents.
4. If necessary, change the NetBackup master server that you want to perform the backup.
   - If there is more than one master server to which you can send your backups, ensure that you are connected to the correct one. Ask your NetBackup administrator if you have questions about which master server to use.
   - Normally, you do not have to switch master servers unless the administrator temporarily moved the backups. (For example, because of a problem on the original master server.) If the change becomes permanent, the administrator should change your default to reflect the other server.
5. Specify what you want to back up, as follows:
   - Expand the **Lotus Notes** object and select the databases or mailboxes you want to back up.
   - Expand the **Transaction Logs** object to select transaction logs for backup.
You cannot select individual transaction log extents for backup. Instead, to back up all transaction log extents, select the **Transaction Logs** object of the tree. NetBackup then queries the Domino server for the list of transaction log extents that are available to be backed up.

6  Select **Actions > Backup**.

7  Select the backup options, as follows:

- When you back up a server partition, provide the absolute path for the `notes.ini` file.
  (On Windows clients, click on the **Lotus Notes Options** tab.)
  Associate this `notes.ini` file with the particular server partition that you want to perform the backup.

- (UNIX or Linux) When you back up one of multiple installations of Domino server, provide the absolute path for the `notes.ini` file. Associate this `notes.ini` file with the Domino installation you want to back up. Also provide the directory of the Domino server installation.

- When you back up one of multiple installations of Domino server, provide the absolute path for the `notes.ini` file. Associate this `notes.ini` file with the Domino installation you want to back up. Also provide the directory of the Domino server installation.

  See “**General Options tab**” on page 48.

  See “**Lotus Notes Options tab**” on page 49.

8  Click **Start Backup**.

---

**About performing a Lotus Notes database restore**

This topic describes how to restore a Lotus Notes database or mailbox. This information is a supplement to the operating instructions in the *NetBackup Backup, Archive, and Restore Getting Started Guide*. Refer to that guide for detailed restore instructions.

Each partition in a Domino server has its own `notes.ini`. Therefore Lotus Notes databases from different partitions must be restored in separate restore operations.

For UNIX or Linux, different installations of Domino server must also be restored in separate restore jobs.

See “**Performing a user-directed backup of a Lotus database**” on page 49.

See “**About performing backups and restores of Lotus Notes databases**” on page 47.
General tab

On this tab you can specify a different location to direct the restore to. By default, everything is restored to its original directory.

Table 4-3  Restore options on the General tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restore everything to its original location</td>
<td>Restores the selected items to the location from which they were backed up. This option is the default.</td>
</tr>
<tr>
<td>Restore everything to a different location</td>
<td>Select to restore to a different location, then enter the location to which you want to redirect the files and directories.</td>
</tr>
<tr>
<td>Destination</td>
<td>Enter the path to restore to. This field is enabled when Restore everything to a different location is selected.</td>
</tr>
<tr>
<td>Browse</td>
<td>This option is available on the Windows interface.</td>
</tr>
<tr>
<td>Browse</td>
<td><strong>Browse</strong> is enabled when Restore everything to a different location is selected. Click it to browse for the destination directory.</td>
</tr>
<tr>
<td></td>
<td>NetBackup browses the local machine where the Backup, Archive, and Restore interface is running. You cannot browse another machine, even if you have chose to redirect a restore to a different client.</td>
</tr>
<tr>
<td>Restore individual folders and files to different locations</td>
<td>This option appears on the Windows interface. Specify a different location for each item. To restore files to different locations, you must mark files (not directories). To specify a different location, double-click an item.</td>
</tr>
<tr>
<td>Restore individual directories and files to different locations</td>
<td>This option appears on the Java interface. Specify a different location for each item. To restore files to different locations, you must mark files (not directories). To specify a different location, select an item and click Change Selected Destinations.</td>
</tr>
<tr>
<td>Create and restore to a new virtual hard disk file</td>
<td>This option is not available for this agent.</td>
</tr>
<tr>
<td>Overwrite existing files</td>
<td>Overwrites existing the files and directories.</td>
</tr>
<tr>
<td>Restore the file using a temporary filename</td>
<td>This option is available on the Windows interface. It does not apply when you restore Lotus Notes databases.</td>
</tr>
</tbody>
</table>
Table 4-3  Restore options on the **General** tab *(continued)*

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Do not restore the file</strong></td>
<td>This option is available on the Windows interface. Prevents any existing files and directories from being overwritten.</td>
</tr>
</tbody>
</table>

**Lotus Notes tab**

The following additional options are available for Lotus Notes restore operations.

Table 4-4  Restore options on the **Lotus Notes** tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time to wait for the database to go offline</strong></td>
<td>Specify the number of seconds that the restore process waits for a busy database. When a database is to be restored it needs to be taken offline. If the database cannot be taken offline after the specified wait time, the restore of that database fails.</td>
</tr>
<tr>
<td><strong>Recover databases to current time</strong></td>
<td>Restores the database to the current date and time. This option is the default.</td>
</tr>
<tr>
<td><strong>Recover database(s) to specified point in time</strong></td>
<td>Select this option to restore a database to a specific date and time. Select either <strong>Assign new database instance ID</strong> or <strong>Assign new database instance ID and replica ID</strong>. <strong>Assign new database instance ID</strong> is the default option.</td>
</tr>
<tr>
<td><strong>No Recovery</strong></td>
<td>Select this option to restore a logged database. For example, select <strong>No Recovery</strong> when you want to restore to a temporary location quickly. No transaction log recovery is performed on the restored database, which lets you get the version of the database at the backup time. Select either <strong>Assign new database instance ID</strong> or <strong>Assign new database instance ID and replica ID</strong>. <strong>Assign new database instance ID</strong> is the default when <strong>No Recovery</strong> is selected.</td>
</tr>
</tbody>
</table>
### Restore options on the Lotus Notes tab (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Database Identification</strong></td>
<td>You can assign a new database instance ID (DBIID), a new database instance ID and replica ID, or retain the original IDs during the restore. The replica ID is used to synchronize two or more databases that are replicated in the Domino environment.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Assign new database instance ID</strong> during a restore to create a new database instance ID, but retain the replica ID. This option is not applicable when you restore unlogged databases.</td>
</tr>
<tr>
<td></td>
<td>Select <strong>Assign new database instance ID and replica ID</strong> during a restore to prevent the other databases under replication from writing over the restored database files. For logged databases, a new database instance ID and a new replica ID are assigned. For unlogged databases, a new replica ID is assigned.</td>
</tr>
<tr>
<td></td>
<td><strong>Retain original IDs</strong> is only available when you restore a database to the current time.</td>
</tr>
<tr>
<td><strong>Wait until resources are available</strong></td>
<td>Select this option to wait for Domino server Resources to become available before NetBackup starts the restore process.</td>
</tr>
<tr>
<td></td>
<td><strong>Windows:</strong> Specify the absolute path for the NOTES.INI file for the server instance</td>
</tr>
<tr>
<td></td>
<td><strong>UNIX or Linux:</strong> Specify the absolute path for the NOTES.INI file associated with the server instance to be used</td>
</tr>
<tr>
<td></td>
<td>To restore a Domino partition server, specify the absolute path for the notes.ini file. This file should be associated with the particular server partition you want to perform the restore.</td>
</tr>
<tr>
<td></td>
<td>(UNIX or Linux) To restore one of multiple Domino server installations, specify the absolute path for the notes.ini file. This file should be associated with the particular server installation you want to perform the restore.</td>
</tr>
<tr>
<td></td>
<td>The server partition you specify affects how a database is restored (if logged). It also affects which set of transaction logs are used for recovery.</td>
</tr>
<tr>
<td><strong>Browse</strong></td>
<td>This option is available on the Windows interface.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Browse</strong> to browse for the directory that contains the notes.ini file.</td>
</tr>
<tr>
<td></td>
<td>NetBackup browses the local machine where the Backup, Archive, and Restore interface is running. You cannot browse another machine, even if you have chose to redirect a restore to a different client.</td>
</tr>
</tbody>
</table>
Table 4-4 Restore options on the Lotus Notes tab (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the directory where Lotus is installed</td>
<td>This option is available on the Java interface. To restore one of multiple Domino server installations on a server, specify the directory where the Lotus program files are installed.</td>
</tr>
</tbody>
</table>

Restoring a Lotus database

You can restore linked databases or directories.

**Note:** The restore jobs that use point-in-time are initiated from the master server can fail with a status 12. Specifically, the automatic restore of Lotus Notes transaction log extents during recovery of the Lotus Notes database can fail. This failure occurs if the install path of the NetBackup master server is different from the install path of the NetBackup client.

See the NetBackup Troubleshooting Guide for more information.

**Warning:** Select only the source databases or directory for restore and not the database links or directory links. If you attempt to restore the links, the actual database is deleted. This situation can lead to data loss if the database has not been backed up.

See the following topics:

- See “Restoring linked databases or directories and manually recreating the link file” on page 56.
- See “Restoring linked databases or directories and the link file” on page 56.

To restore a Lotus Notes database

1. On the NetBackup client, open the Backup, Archive, and Restore interface.
2. (UNIX or Linux) Log on as Domino server administrative user.
3. (Windows) Select File > Select Files and Folders to Restore > from Normal Backup.
4. (UNIX or Linux) Click the Restore Files tab.
5. Select the server, client, and policy type.
   - (Windows) Select File > Specify NetBackup Machines and Policy Type.
   - (UNIX or Linux) Select Actions > Specify NetBackup Machines and Policy Type.
6  Provide the following information:

- **Server to use for backups and restores**: Select the server you want to perform the operation.
- **Source client for restores**: Select the client on which the backup was performed.
- **Policy type for restores**: Select *Lotus-Notes*.

7  Click **OK**.

8  (UNIX or Linux) Select **View > Show Most Recent Backup**.

9  (UNIX or Linux) Select **View > Refresh**.

   NetBackup browses for Lotus Notes database backup images.

10 Select the database or mailbox you want to restore.

   Generally, you should not select transaction log extents for a restore. If a transaction log extent is required to recover a database, it is restored automatically as part of the database recovery. It is recycled automatically by the Domino server when the transaction log extent is no longer required.

   The **Browse Directory** box is not available when you browse for Lotus Notes backups on a NetBackup UNIX client.

11 Select **Actions > Restore**.

12 On the **Lotus Notes** tab, choose the recovery option.

   See “**General tab**” on page 51.

   See “**Lotus Notes tab**” on page 52.

13 Select the database identification option from among the following:

   - To restore a logged database to an alternate location on same server: Select **Assign new database instance ID**.
   - To restore to a point in time: Select **Assign new database instance ID**.
   - To disable replication on restore: Select **Assign new database instance ID and replica ID**.
   - (UNIX or Linux) To perform a restore of multiple instances or of partitioned server: Specify the *notes.ini* and install path for the Domino server.
   - If the database is in use: Specify the **Time to wait for database to go offline (seconds)**.
14. To restore from a server partition, provide the absolute path for the `notes.ini` file. This file is one associated with the particular server partition that you want to perform the restore.

15. (UNIX or Linux) To restore one of multiple installations of Domino server, provide the absolute path for the `notes.ini` file.
   
   This file should be associated with the server installation. Also provide the directory of the Domino server installation.

16. Click **Restore** or **Start Restore**.

See “About performing a Lotus Notes database restore” on page 50.

See “About performing backups and restores of Lotus Notes databases” on page 47.

See “Restoring linked databases or directories and manually recreating the link file” on page 56.

### Restoring linked databases or directories and manually recreating the link file

The following procedure describes how to restore linked databases or directories and manually recreating the link file.

**Warning:** Do not restore the link file.

#### To restore a linked database or directory

1. Restore the database file to the directory that is referenced in the database or the directory link.

2. Once the restore is complete, manually recreate the link file in the Domino data directory.

See “Restoring a Lotus database” on page 54.

See “Restoring linked databases or directories and the link file” on page 56.

See “About performing backups and restores of Lotus Notes databases” on page 47.

### Restoring linked databases or directories and the link file

The following procedure describes how to restore linked databases or directories and the link file.
Warning: Failure to move the actual database before you restore the link file can lead to data loss. If you only restore the link, Domino deletes the database that the link references.

To restore a linked database or directory and the link file

1. Restore the database file to the directory that is referenced in the database or the directory link.
2. Move the databases that the link file references to a temporary location.
3. Restore the database link file.
4. Move the actual databases back to their original location.
5. On the NetBackup client, open the Backup, Archive, and Restore interface.

See “About performing backups and restores of Lotus Notes databases” on page 47.
See “Restoring linked databases or directories and manually recreating the link file” on page 56.

Redirecting a Lotus Notes restore to a different client

A restore redirected to a different client is performed like a regular restore except that a different destination client is selected. Optionally, a different source client can also be selected.

You can also perform a standard restore.

See “About performing a Lotus Notes database restore” on page 50.

Note: The point-in-time restore jobs that are initiated from the master server can fail with a status 12. Specifically, the automatic restore of Lotus Notes transaction log extents during recovery of the Lotus Notes database can fail. This failure occurs if the install path of the NetBackup master server is different from the install path of the NetBackup client.

See the NetBackup Troubleshooting Guide for more information.

To redirect a Lotus Notes restore to a different client

1. On the NetBackup client, open the Backup, Archive, and Restore interface.
2. (Windows) Open a Restore window.
   (UNIX or Linux) Click the Restore Files tab.
3  (Windows) Select **Actions > Specify NetBackup Machines and Policy Type.**
   (UNIX or Linux) Select **File > Specify NetBackup Machines and Policy Type.**

4  From the **Source client for restores** list, select the client.
   The source client is the computer name whose backup images you want to browse.

5  From the **Policy type for restores** list, select **Lotus-Notes.**

6  From the **Destination client for restores** list, select the client to which to redirect the restore.
   The NetBackup for Lotus Notes agent must be installed on the destination client.

7  Click **OK.**
   NetBackup browses for Lotus Notes backup images.

See “About performing backups and restores of Lotus Notes databases” on page 47.
See “Restoring a Lotus database” on page 54.
See “Performing a user-directed backup of a Lotus database” on page 49.
See “About restoring individual Lotus Notes documents or mail messages” on page 58.
See “Recovering the Lotus Notes environment” on page 59.

### About restoring individual Lotus Notes documents or mail messages

The NetBackup for Lotus Notes agent restores entire Lotus Notes databases. To restore individual documents or mail messages, restore the entire database under a temporary name on the production server or an alternate server. Once the restore completes, you can copy individual documents or mail messages from the temporary database into the actual database with the Lotus Notes client.

See “About performing backups and restores of Lotus Notes databases” on page 47.
See “Restoring linked databases or directories and the link file” on page 56.
See “About performing user-directed backups of a Lotus Notes database” on page 48.
Recovering the Lotus Notes environment

If you need to recreate the Lotus Notes environment, restore both Lotus Notes databases and regular files from backup.

To recover the Lotus Notes environment

1. Reinstall the Domino server software.
2. Restore the Domino configuration files (*.id) from the file system backup image.
   Restore these files to the path of the current Domino server installation.
3. Configure the Domino server.
   The *.id files that were restored in the previous step can be used to configure the Domino server for the first time.
4. If the previous Lotus Notes environment had transaction logging enabled:
   - Enable transaction logging on the new Domino server, by using the Domino Administrator application.
   - Restart the Domino server to create new transaction logs.
5. Shut down the Domino server.
6. Make the following change in the notes.ini file.
   
   TRANSLOG_Status=0

7. Add the following line to the notes.ini file:

   TRANSLOG_mediaonly=1

8. Move or delete any files that may exist in the translog_path directory.
   For example, nlogctrl.lfh or any transaction log extents.
9. Copy the transaction log extents from the previous Domino server installation into the current transaction log directory.
   Or, you can restore the transaction log extents by using the Backup, Archive, and Restore interface. The transaction log extents should have a timestamp later than the timestamp of the backup image from which the databases are restored.
10  Make the following changes to the notes.ini file:

TRANSLOG_Status=1
TRANSLOG_MediaOnly=1
TRANSLOG_Style=1

11  Start the Domino server to create the new control file of the restored transaction log extents.

12  Shut down domino server.

13  Use the Backup, Archive, and Restore interface to restore the Lotus Notes databases or mailboxes from the Lotus Notes backup image, as follows:

■ If transaction logging is enabled, select the point-in-time to which you want to recover the databases.
■ If point-in-time is not selected, the database rolls forward to the most recent available version.

14  After the recovery of the Lotus Notes databases is complete, make the following change to the notes.ini file.

TRANSLOG_MediaOnly=0

(Or, remove the setting from notes.ini.)

15  Start the Domino server.

If backup images of non-Lotus Notes databases are not available, you can configure the newly installed Domino server by creating new *.id files.

See “About performing backups and restores of Lotus Notes databases” on page 47.
See “Performing a user-directed backup of a Lotus database” on page 49.
See “About performing a Lotus Notes database restore” on page 50.
See “Restoring linked databases or directories and the link file” on page 56.
Domino clustering

This chapter includes the following topics:

- About Domino clustering components
- Backing up a Domino replicated or clustered environment
- About the restore and recovery in a Domino replicated or clustered environment

About Domino clustering components

Several components work together to control a Domino cluster. These components include the Cluster Manager, the Cluster Database Directory, the Cluster Database Directory Manager, and the Cluster Replicator.

The Cluster Manager runs on each server in a Domino cluster and monitors the state of the other servers in the Domino cluster.

The Cluster Manager performs the following tasks:

- Determines which servers belong to the Domino cluster
- Monitors for server availability and workload
- Fails over database requests due to unavailability of a clustered Domino server
- Performs workload balancing

The Cluster Database Directory (CLDBDIR.NSF) is replicated on every server in a Domino cluster. The Cluster Database Directory contains information for each database on each server in the Domino cluster. This information includes file name, server, replica ID, cluster replication status, and out-of-service information. The different cluster components use this information to perform their tasks.

The Cluster Database Directory Manager (CLDBDIR) task on each server manages the Cluster Database Directory and keeps it up to date. The Cluster Database
Directory Manager also monitors the status of each database to determine if they are out of service or not yet deleted.

The Cluster Replicator (CLREPL) task constantly synchronizes the database replicas in a Domino cluster. Changes to the database are pushed immediately to the other replicas in the cluster. This event-drive replication ensures that each time a database is accessed that it contains the most up-to-date data. The Cluster Replicator task pushes changes only to those servers in a Domino cluster. The traditional scheduled replication is used to replicate changes to and from servers outside a Domino cluster.

Because Domino stores replication events in memory only, both the source server and destination server must be available for the replication to complete successfully. If a destination server is not available, the replication events are stored on the source server until the destination server becomes available. If the source server shuts down before the replication completes, the replication events in memory are lost. To prevent this loss, configure immediate replication with all members of the Domino cluster whenever a Domino cluster server is restarted. Perform scheduled replications between Domino clustered servers on a regular basis to help maintain database consistency for all members of the Domino cluster.

See “Backing up a Domino replicated or clustered environment” on page 62.

See “About the restore and recovery in a Domino replicated or clustered environment” on page 63.

See “About the restore and recovery in a Domino replicated or clustered environment” on page 63.

See “About Domino partitioned servers” on page 66.

### Backing up a Domino replicated or clustered environment

If you use transaction logging, configure your Domino cluster environment as follows:

- Enable archive-style logging on the server that functions as your backup server.
- Enable circular-style or linear-style logging on all other servers in the Domino cluster.
  
  By running circular-style or linear-style logging on the non-backup servers, you have all the advantages of transaction logging. These advantages include data reliability and integrity. Also, improved performance can be attained without having to manage (recycle) the archival-style transaction logs.
- Back up the Domino files that are not part of the database as part of a standard backup.
These files include the notes.ini, user certificates IDs, server certificates IDs, and the cluster.ncf.

See “About Domino clustering components” on page 61.

See “About the restore and recovery in a Domino replicated or clustered environment” on page 63.

See “About performing backups in a Domino partitioned server environment” on page 67.

About the restore and recovery in a Domino replicated or clustered environment

Domino clustering is a “software” clustering solution that relies on software replication to provide consistency of the databases across all members of the cluster. To achieve the result you want, knowledge of how replication functions is vital.

See “Example of clustered environment with three Domino servers” on page 64.

See “Example of clustered environment with four Domino servers” on page 63.

See “Backing up a Domino replicated or clustered environment” on page 62.

See “About Domino clustering components” on page 61.

See “About Domino partitioned servers” on page 66.

Example of clustered environment with four Domino servers

The environment is a Domino clustered environment with four Domino servers as members of the Domino cluster. Server A is identified as your backup server and runs archive-style transaction logging. Servers B, C, and D run circular or linear-style logging. To provide load balancing across all the servers, replicas of all databases exist on all four servers in your Domino cluster. A successful full backup of all databases was completed earlier in the week. Successful incremental backups of the archival-style transaction logs are completed every four hours, with the last one completing two hours ago. At 2:30 P.M., a user complains that the database acme.nsf is corrupted, while they modified the database on server C over the last 30 minutes. Unfortunately, because the environment is a Domino cluster environment, the corruption is replicated to all four member servers. The users state that the database was in a consistent state when they began to modify the database.

To restore a database to a consistent state do the following:
On server A, perform a point-in-time recovery of the database `acme.nsf`. Select the database `acme.nsf` from the last successful backup of the database (for example, a full backup that was completed successfully earlier in the week). Begin the restore.

On the Lotus Notes tab of the Restore Marked Files dialog box, select the Assign new database instance ID and replica ID option. Select the Recover database(s) to specified point in time option. Specify today's date at 2:00 P.M. (the time that the user started to modify the database) as the point-in-time for recovery.

After the restore or recovery is successful, a version of `acme.nsf` from 2:00 P.M. today should exist on server. Verify the consistency of `acme.nsf` on server A. If all is as expected, from server A create new replicas of `acme.nsf` on servers B, C, and D. Cluster replication should now be functional on servers A, B, C, and D, with a consistent version of `acme.nsf`.

See “About the restore and recovery in a Domino replicated or clustered environment” on page 63.

See “About Domino partitioned servers” on page 66.

See “Example of clustered environment with three Domino servers” on page 64.

### Example of clustered environment with three Domino servers

The environment is a Domino clustered environment with three Domino servers as members of the Domino cluster. Server C is identified as your backup server and is running archive-style transaction logging. Servers A and B are running circular-style or linear-style logging. To provide high availability and load balancing of mail, replicas exist on several servers. Databases A-L exist on servers A and C. Databases M-Z exist on servers B and C. A successful full backup of all databases was completed earlier in the week. Successful incremental backups of the archive-style transaction logs are completed every four hours, with the last one completing two hours ago. Today a user discovers that 30 mail messages were accidentally deleted. They were deleted yesterday at about 3:30 P.M. and were stored in the database `mander.nsf`.

To recover accidentally deleted mail messages do the following:

On server C, perform a point-in-time recovery of the following database:

- **UNIX or Linux:** `/mail/mander.nsf`
- **Windows:** `mail\mander.nsf`

Select the database from the last successful backup of the database (for example, the full backup that was completed successfully earlier in the week). Begin the restore.
On the Lotus Notes tab of the Restore Marked Files dialog box, select the Assign new database instance ID and replica ID option. Select the Recover database(s) to specified point in time option. Specify yesterday’s date at 3:25 P.M. (the time right before the user deleted the mail messages) as the point-in-time for recovery.

A version of the database is recovered to yesterday at 3:25 P.M. and a database that contains the deleted messages should exist on server C. Verify the existence of messages in the mander.nsf database on server C. If all is as expected, copy the accidentally deleted messages from the database on server C to the database on server B.

After the copy, verify the existence of the messages in the database on server B. If all is as expected, from server B create a new replica of the following database on server C.

Windows: mail\mander.nsf
UNIX and Linux: /mail/mander.nsf

Cluster replication should now be functional for the database on servers B and C.

In this example the Assign new database instance ID and replica ID option is chosen. If the Assign new database instance ID option was chosen instead, the final results of the recovery would be different. The restored database would function the same, except that the replica ID would not be changed. The database would be recovered to the specified point-in-time. However, because the replica ID was not changed during the restore, it would match the replica ID on server B. Therefore, all the changes to the database between the point-in-time to which the database was recovered and the current time (including the deletion of the 30 mail messages) eventually is replicated to the database on server C. Two identical copies of the database exist, one on server B and the other on server C. Both copies are the same as when the restore was started on server C.

See “About the restore and recovery in a Domino replicated or clustered environment” on page 63.

See “About Domino partitioned servers” on page 66.

See “Example of clustered environment with four Domino servers” on page 63.
Domino partitioned servers

This chapter includes the following topics:

- About Domino partitioned servers
- About performing backups in a Domino partitioned server environment
- About restoring a Domino partitioned server environment

About Domino partitioned servers

Domino partitioned servers allow multiple Domino servers to run on a single computer. The advantages of using Domino partitioned servers are to reduce hardware expenses and minimize the number of computers to administer. Each Domino partitioned server has its own Domino data directory and notes.ini file. All partitioned servers on a single computer share the same Domino program directory.

Use different user accounts for each partitioned server. With different user accounts, you can easily use commands such as nsd to clean up orphaned processes after a server crash. The database agent easily supports backups and restores of multiple server partitions with each using a different user account. It is possible to backup multiple Lotus partitions from a single NetBackup policy; however, back up each partition by using a separate data stream.

See “About performing backups in a Domino partitioned server environment” on page 67.

See “About restoring a Domino partitioned server environment” on page 68.

See “About performing backups and restores of Lotus Notes databases” on page 47.
About performing backups in a Domino partitioned server environment

The following examples illustrate two possible configurations of the backup selections list that can be used to back up a Domino partitioned server environment.

### Table 6-1 Backup selections list examples

<table>
<thead>
<tr>
<th>Environment</th>
<th>Backup policy</th>
</tr>
</thead>
<tbody>
<tr>
<td>The environment is a Domino partitioned server environment with two partitions. The Domino data directory for partition 1 is located at D:\Lotus\Domino\data1. The Domino data directory for partition 2 is located at D:\Lotus\Domino\data2.</td>
<td>To back up this environment with two separate NetBackup policies, add the following to the backup selections list: Policy 1</td>
</tr>
<tr>
<td>The Domino data directory for partition 1 is located at D:\Lotus\Domino\data1. The Domino data directory for partition 2 is located at D:\Lotus\Domino\data2.</td>
<td>NOTES_INI_PATH=D:\Lotus\Domino\data1\notes.ini D:\Lotus\Domino\data1\</td>
</tr>
<tr>
<td>Policy 2</td>
<td>NOTES_INI_PATH=D:\Lotus\Domino\data2\notes.ini D:\Lotus\Domino\data2\</td>
</tr>
<tr>
<td>The environment is a Domino partitioned server environment with two partitions. The Domino data directory for partition 1 is located at /db/notesdata1. The Domino data directory for partition 2 is located at /db/notesdata2.</td>
<td>To back up this environment with two separate NetBackup policies, add the following to the backup selections list: Policy 1</td>
</tr>
<tr>
<td>The Domino data directory for partition 1 is located at /db/notesdata1. The Domino data directory for partition 2 is located at /db/notesdata2.</td>
<td>NOTES_INI_PATH=/db/notesdata1\notes.ini /db/notesdata1</td>
</tr>
<tr>
<td>Policy 2</td>
<td>NOTES_INI_PATH=/db/notesdata2\notes.ini /db/notesdata2</td>
</tr>
<tr>
<td>Environment</td>
<td>Backup policy</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>The environment is a Domino partitioned server environment with three partitions. The Domino data directory for each partition is located as follows:</td>
<td>Each partition is configured to use archive-style transaction logging. To back up this environment with a single NetBackup policy, add the following to the backup selections list:</td>
</tr>
<tr>
<td>- Partition 1, D:\Lotus\Domino\data1</td>
<td>NEW_STREAM</td>
</tr>
</tbody>
</table>
| - Partition 2, D:\Lotus\Domino\data2 | NOTES_INI_PATH=D:\Lotus\Domino\data1
BACKUP_TRANSACTION_LOGS |
| - Partition 3, D:\Lotus\Domino\data3 | NEW_STREAM |
| The environment is a Domino partitioned server environment with three partitions. The Domino data directory for each partition is located as follows: | Each partition is configured to use archive-style transaction logging. To back up this environment with a single NetBackup policy, add the following to the backup selections list: |
| - Partition 1, /db/notesdata1 | NEW_STREAM |
| - Partition 2, /db/notesdata2 | NOTES_INI_PATH=/db/notesdata1/notes.ini
/db/notesdata1
BACKUP_TRANSACTION_LOGS |
| - Partition 3, /db/notesdata3 | NEW_STREAM |

### About restoring a Domino partitioned server environment

The user who owns the partition’s Domino data directory must restore the partitioned server. For Domino server, the notes.ini file determines how a database to be restored is accessed and which Lotus transaction log extents to use for recovery.
Because each partition in a partitioned server environment has its own `notes.ini`, restore databases from different partitions in separate restore operations.

See “About Domino partitioned servers” on page 66.

See “About performing a Lotus Notes database restore” on page 50.

See “Recovering the Lotus Notes environment” on page 59.
Domino server multiple installations (UNIX or Linux)

This chapter includes the following topics:

- About Domino server multiple installations
- About configuring NetBackup for a multiple Domino server environment
- About backups in a multiple Domino server environment
- About restores a multiple Domino server environment

About Domino server multiple installations

Multiple Domino server installations of same or different versions allow multiple Domino servers to run on a single computer. These versions can be standalone or partitioned or a combination of both. The advantages of using Domino partitioned servers are to reduce hardware expenses and minimize the number of computers to administer. Each Domino server installation has its own Domino data directory and notes.ini file.

The NetBackup for Lotus Notes agent uses different UNIX user account for each installation. When you use different accounts it is easier to use commands such as nsd to clean up orphaned processes after a Domino server crash. To accommodate this recommendation, it is possible to back up multiple Domino installations from a single NetBackup policy. However, each installation must be backed up by using a separate data stream.

See “About configuring NetBackup for a multiple Domino server environment” on page 71.

See “About backups in a multiple Domino server environment” on page 71.
About configuring NetBackup for a multiple Domino server environment

Run the following script to configure the NetBackup to support backups and restores of a multiple Domino server environment.

Run the following script from NetBackup's bin directory:

```
$./lotusnotes_config
```

Enter the Lotus install path for each Domino installation. For example:

```
/opt/lotus655/lotus
```

See “About Domino server multiple installations” on page 70.

See “About backups in a multiple Domino server environment” on page 71.

See “About restores a multiple Domino server environment” on page 72.

About backups in a multiple Domino server environment

The following examples illustrate possible configurations of the backup selections list when used to back up a Lotus multiple server installation environment.

<table>
<thead>
<tr>
<th>Environment</th>
<th>NetBackup policy</th>
</tr>
</thead>
</table>
| The environment is a multiple Domino server installation environment that runs with two installations. For example: installation 1 of 7.5 version and installation 2 of 7.6 version are installed at /opt/lotus75/lotus and /opt/lotus76/lotus respectively. The Domino data directory for installation 1 is located at /db/notesdata1 and the Domino data directory for installation 2 is located at /db/notesdata2. | To back up this environment with two separate NetBackup policies, add the following to the backup selections list: Policy 1
NOTES_INI_PATH=/db/notesdata1/notes.ini
NOTES_INSTALL_PATH=/opt/lotus75/lotus
/db/notesdata1
Policy 2
NOTES_INI_PATH=/db/notesdata2/notes.ini
NOTES_INSTALL_PATH=/opt/lotus76/lotus
/db/notesdata2 |
Table 7-1  Multiple Domino server examples (continued)

<table>
<thead>
<tr>
<th>Environment</th>
<th>NetBackup policy</th>
</tr>
</thead>
</table>
| The environment is a multiple Domino server installation environment that runs with three installations. For example: installation 1 of 7.1 version, installation 2 of 7.5 version, and installation 3 of 7.6 version are installed at `/opt/lotus71/lotus`, `/opt/lotus75/lotus` and `/opt/lotus76/lotus`, respectively. The Domino data directory for installation 1 is located at `/db/notesdata1`, the Domino data directory for installation 2 is located at `/db/notesdata2`, and the Domino data directory for installation 3 is located at `/db/notesdata3`. Each installation is configured to use archive style transaction logging. | To back up this environment with a single NetBackup policy, add following to the backup selections list: Policy 1

NEW_STREAM
NOTES_INI_PATH=/db/notesdata1/notes.ini
NOTES_INSTALL_PATH=/opt/lotus71/lotus
/db/notesdata1
BACKUP_TRANSACTION_LOGS
NEW_STREAM
NOTES_INI_PATH=/db/notesdata2/notes.ini
NOTES_INSTALL_PATH=/opt/lotus75/lotus
/db/notesdata2
BACKUP_TRANSACTION_LOGS
NEW_STREAM
NOTES_INI_PATH=/db/notesdata3/notes.ini
NOTES_INSTALL_PATH=/opt/lotus76/lotus
/db/notesdata3
BACKUP_TRANSACTION_LOGS |

See “About Domino server multiple installations” on page 70.
See “About configuring NetBackup for a multiple Domino server environment” on page 71.
See “About restores a multiple Domino server environment” on page 72.

About restores a multiple Domino server environment

As with restores of a standalone Domino server environment, the user owns the Domino data directory for the installation that must restore the server installation. For Domino server, the notes.ini file determines how a database to be restored is accessed and which Lotus transaction log extents to use for recovery. Because each Domino server installation has its own notes.ini, Lotus Notes databases from different installations must be restored in separate restore operations.

See “About backups in a multiple Domino server environment” on page 71.
See “About Domino server multiple installations” on page 70.
See “About configuring NetBackup for a multiple Domino server environment” on page 71.
About NetBackup for Lotus Notes debug logging

The NetBackup master server and client software offers a comprehensive set of debug logs for troubleshooting problems that can occur during NetBackup operations. Debug logging is also available for Domino Server backup and restore operations.

See the following topics for information on how to create the logs and how to control the amount of information written to the logs.

See “Enabling the debug logs for a NetBackup for Lotus Notes client automatically (Windows)” on page 74.

See “Debug logs for NetBackup for Lotus Notes backup operations” on page 74.

See “Debug logs for NetBackup for Lotus Notes restore operations” on page 74.

See “Setting the debug level on a NetBackup for Lotus Notes Windows client” on page 75.

See “Setting the debug level on a UNIX client” on page 75.

After you determine the cause of the problem, disable debug logging by removing the previously created debug logging directories. Details are available on the contents of these debug logs.

See the NetBackup Troubleshooting Guide.
Additional information about NetBackup client logs and NetBackup master server logs is available.
See the online help for the Backup, Archive, and Restore interface.
See the NetBackup Administrator’s Guide, Volume I.

---

Note: When debug logging is enabled, the files can become large. The same files are used by normal file backups.

---

Enabling the debug logs for a NetBackup for Lotus Notes client automatically (Windows)

You can enable debug logging by running a batch file that creates each log directory. To create all log file directories automatically, run the following:

```
install_path\NetBackup\logs\mklogdir.bat
```

Debug logs for NetBackup for Lotus Notes backup operations

To turn on debug logging for standard backup operations, create the following:

(Windows) `install_path\NetBackup\logs\bpbkar`

(UNIX or Linux) `/usr/openv/netbackup/logs/bpbkar`

See “About NetBackup for Lotus Notes debug logging” on page 73.
See “Setting the debug level on a NetBackup for Lotus Notes Windows client” on page 75.

Debug logs for NetBackup for Lotus Notes restore operations

To turn on debug logging for restore operations, create the following directory:

```
install_path\NetBackup\logs\tar
/usr/openv/netbackup/logs/tar
```

For all restores, tar logs exist on the primary client.
See “About NetBackup for Lotus Notes debug logging” on page 73.
See “Setting the debug level on a NetBackup for Lotus Notes Windows client” on page 75.
Setting the debug level on a UNIX client

The debug logs are located in /usr/openv/netbackup/logs.

To set the debug level on a UNIX client

♦ Enter the following line in the bp.conf file.

    VERBOSE = \n
Where X is the debug level you want.

Setting the debug level on a NetBackup for Lotus Notes Windows client

To control the amount of information that is written to the debug logs, change the “General” debug level. Typically, the default value of 0 is sufficient. However, technical support may ask you to set the value higher to analyze a problem.

The debug logs are located in install_path\NetBackup\logs.

To set the debug level on a NetBackup for Lotus Notes client

1 Open the Backup, Archive, and Restore program
2 Select File > NetBackup Client Properties.
3 Click the Troubleshooting tab.
4 Set the General debug level.
5 Click OK to save your changes.

About NetBackup status reports

NetBackup provides many standard status reports to verify the completion of backup and restore operations. In addition, users and the administrator can set up additional reports if a site requires them.

The administrator has access to operational progress reports through the NetBackup Administration Console. Reports can be generated for Status of Backups, Client Backups, Problems, All Log Entries, Media Lists, Media Contents, Images on Media, Media Logs, Media Summary, and Media Written. These reports can be generated for a specific time frame, client, or master server.

See the NetBackup Administrator’s Guide, Volume I for details.

Progress reports on the client allow easy monitoring of user operations. When reports are created by the NetBackup client for each user-directed backup or restore
operation, administrators can monitor these operations and detect any problems that may occur.

**Viewing the progress report of a NetBackup for Lotus Notes operation**

This topic describes how to view the progress report of a NetBackup for Lotus Notes backup or restore operation.

**To view the progress report of a NetBackup for Lotus Notes operation**

1. Click the **Task Progress** tab.
2. Click **Update Task List**.
3. Choose **File > View Status**.
4. Click the task for which you want to check the progress.
5. Click **Refresh**.

More information is available on progress reports and the meaning of the messages.

See the [NetBackup Backup, Archive, and Restore Getting Started Guide](#).
A
Allow multiple data streams 32

B
backup
  automatic 45
  manual 45
backup media required 19
backup selections list 37
backups
  automatic 11
  described 15
database types supported 12
manual
  described 15
master server selected 49
of database links 43
of directory links 43
of UNIX NFS directories 42
of Windows network shared folders 42
user directed 36
user-directed
  described 15

C
checkpoint restart 32
clients list, for backup policies 37
compatibility information 19

D
DB2
  using with Lotus Notes databases 9
debug logs 73
    debug level 75
    enabling 74
    for backup operations 74
    for restore operations 74

E
excluding databases from backups 42

F
files
  NOTES.INI 29

I
INI file, for Lotus Notes 29
installation
  adding a license key 20
  requirements for NetBackup clients 19
  requirements for NetBackup servers 19
installations, adding (UNIX or Linux) 21

L
license keys 20
Lotus
  home path 20
Lotus Notes
    host properties 28

M
master server
  selected for backups 49
Maximum number of logs to restore 25
Maximum number of logs to restore property 28
multiple
  installations 28

P
policy configuration
  adding clients 37
  attributes 32
Backup Selections list 37
  for databases 31
overview 30
schedules 33
testing 45
user backups 36
R
recovery of Lotus Notes environment 59
redirected restores
to different clients 57
to different paths 16
remote folder button 39
reports
client 75
media 75
operational 75
restores
configuring fast restores 23
redirected. See redirected restores

S
schedules
adding 33
frequency 33
properties 33
supported database types 12

T
tar log 74
testing policy configuration 45
Transaction log cache path 24
Transaction log cache path property 29
transaction logs
backups 10
troubleshooting
NetBackup debug logs 73
status of NetBackup operations 75

U
UNIX NFS directories
backups of 42
user backups 36

W
Windows network shared folders
backups of 42